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Welcome To DC SEVEN.   
 
You will be using the world’s most advanced system for removing noise, sweetening the general sound of 
your audio and editing that audio with a complete professional audio toolkit.  In short…DC SEVEN will 
give you the best opportunity to make your favorite recordings sound young again.   
 
We’re going to take you by the hand and lead you through four separate examples of audio restoration and 
enhancement.  This demo gives you a complete working copy of the software, but for a limited time.  The 
clock starts clicking when you install, so make sure you get a full evaluation before your time limit runs 
out.  When you are done, you’ll be licensed to drive the product yourself without training wheels. 
 
Before we start the product, let’s just make a few quick assumptions: 

1. You have the Line output on your sound card plugged into powered speakers.  If you hear sound 
whenever Windows wakes up, chances are, you’re ready to go. 

2. You have Windows XP or Vista, a reasonably fast computer (400 mhz or faster), a mouse and a 
sound card. 

3. You’ve got old recordings of music or speech that you want to vastly improve.   
 
 
Let’s install the software. Everything that requires action on your part will be in bold.   
 
Just download the DC7SetupEa.msi and either double click on it or click once on it and hit your Enter 
button.   

• It will ask you if you want to install, just click on “Next”.   
• It will then ask you to agree to the license agreement.  Again, click “Yes”.  
• Follow the instructions tell it you want the evaluation and let it run.  After it installs, it will put this 

icon on your desktop.   

 
  

 
Still with us?  Good.  Let’s do something. 
 
This entire training process should take you about 10 minutes and will give you all the basics you need to 
know to use the program.   
 
In these Guides, we’ll tell you exactly what to do and even explain why it is you are doing these things.  
It’s important that you follow along exactly as one step builds upon the next.    
 
 
Super Easy Record Restoration Step By Step Guide 
 
First, we need to run the program.  If it’s not already up, just double click the icon on your desktop or click 
once and hit the Enter button to start it.  DC SEVEN starts by introducing you to the new Tune Library 
and asking if you want it to track and label every audio file (WAV, MP3, WMA) on your computer.  It 
looks like this: 



 
This is very cool and useful for a full time user because you will never lose an audio file on your hard disk 
again.  This librarian keeps you audio life nice and organized,  but for this evaluation, just click on “No”.  
Next you’ll see a tip screen, which offers quick suggestions as to how to use the program.   
 

 
 
You can disable this by clicking on the check box in this screen.   
 
If you are new to audio restoration and feel a bit intimidated with the large number of filters and tools in 
DC SEVEN, then EZ Clean is for you.  Our first guide is designed to get you going almost instantly.  Our 
EZ-Clean filter will remove clicks, pops, hiss and surface noise from music recordings almost instantly.  
Here we go. 
  
Now we want to open an audio file to start the demo.  After DC SEVEN Opens, just click on File, then 
click on Open Source.  You’ll see a Window that looks like this: 



 

 
 
 
Next, open the Demo1 Wave file by double-clicking on it.    
 
Note:  If your computer doesn’t automatically open to this “Wavefiles” subdirectory, no worries, several 
machines we’ve tested default to the “My Documents” directory.  In that case, simply click on the arrow 
pointing down just under the Open menu bar and beside the My Documents entry and navigate to C: (or 
whatever your main drive letter is) –Program Files-Diamond Cut Productions- DC SEVEN DEMO- 
Wavefiles and you’ll now see a screen that looks just like the one above.  It should have 2 wave files in it 
named “demo1” and “RadioDemo”. 
 
After you’ve opened the file, your DC SEVEN should look like this:  
 



 
 
Now we’re going to activate the transport system within DC SEVEN so that you can hear this file.   

  The transport system has 3 buttons that we’ll worry about right now. If you’ve ever 
worked with a standard cassette tape recorder, these will all seem very familiar to you.   
 

 This is the Record Button 
 

 This is the Stop Button 
 

 This is the Play Button 
 
Listen to this file by either clicking the Play button or hitting the spacebar – Ouch, this file is full of clicks, 
hiss, low frequency noise, etc.  It’s a mess.   Stop the playback when you’re done listening.  You can do 
this by either hitting the space bar again or by using the Stop button. 
 



Now for the fun part.  Click the Filter Menu and choose EZ-Clean.  The filter looks like this: 
 

 
 

 
 
Notice that there are only three sliders, one for scratches or clicks, one for crackle (or small clicks) and 
another for hiss or other continuous type noises.  We are simply going to listen to the audio and move these 
three sliders as we listen.   
 
Move each slider to approximately the settings shown above.  We don’t need to be perfectly accurate, just 
set them similar to what you see.  When you move these sliders to the left, the filtering becomes more 
aggressive.  Now click the Preview button.  You’ll start to hear the audio.  
 
Listen for a second or two.  Now click the checkbox labeled Bypass.  This “bypasses” the filter and stops 
the filtering.  You are now hearing the original music without the filters in place.  Note the large amount of 
clicks and hiss.   Uncheck the Bypass box to start filtering again.  What a relief!  That’s much better isn’t 
it?  But, you can do better yet.   Move the Hiss slider a bit farther to the left until you get all the noise out.   
Remember, moving the sliders to the left, makes them filter more, so just slide them until you are happy 
with the result. 
 
Want to have some more fun?  Click on Keep Residue.  This filter lets you hear the noise that DC SEVEN 
is removing…some times, it’s easier to hear what you’re taking out than hearing what’s left.  This can be a 
useful tool when you’re close to finished and want to make sure you’ve removed only what you want to 
remove. 
 
Now note the Hum filter on the EZ-Clean screen.  If you live in the US, you’ll check the 60hz box to 
remove power line hum.  If you live in Europe, you’ll check the 50hz box.  There are many other tools to 
remove larger amounts of hum in DC SEVEN, but this one is quick and easy. 
 



Now, stop the preview by clicking on the Cancel Button in the Preview box.  Click on Run Filter and you 
now have a file that is fully cleaned!   Could this possibly be any easier?  Note how visually different this 
after file appears.  Hit Close on the EZ Clean.  You begin to see what “noise” actually looks like. 
 

 
 
Please continue on with the Easy Restoration guide below.  It starts your education on how to use 
individual tools and goes into more depth on the overall concept of DC SEVEN.   
   
Easy Record Restoration Step By Step Guide 
 
Since EZ-Clean is so easy, you don’t really get a feel for the overall program.  This guide assumes you will 
use individual tools and will perform a restoration in a series of steps.   
 
For this demonstration, we’re going to set our workspace to Classic editing mode.  This mode features 2 
waveform views on the screen rather than the single screen you’re seeing in our current Fast Edit Mode.  
To activate Classic Editing mode, just go to your Edit menu, click on Preferences and click on the 
checkbox to uncheck Fast Edit Mode.   Then go to your File Menu and click on Close Source.  Now 
just click Open Source and Open “demo1.wav” again. 
 
Now you’ll see a split screen with the familiar noisy “demo1” on top and nothing on the bottom.  You have 
two windows…Source and Destination.  The Source window is on top and currently has demo1 in it.  The 
Source window is always the file you want to work on and the Destination file always contains a file that 
you’ve just filtered.  As you step through the restoration and enhancement process, you’ll have a continual 
running Before and After process.  Because so much of restoration is based on trying things to see if you 
like them, this method has been proven very successful for restoration enthusiasts.   
 
You work with DC SEVEN by choosing filters to apply to audio.  Some of the filters remove noise and 
others enhance the audio though they are all referred to in this guide as filters.  You choose a filter by 



identifying the type of noise you want to remove and then selecting the filter that removes that type of 
noise.  Make sense so far, right? 
 
In just about every case when clicks and pops are present, we want to remove them first.  Trust us, this is 
the right first step whenever you get clicks and pops on records or other recordings. 
 
To remove the clicks, we’ll choose the EZ Impulse filter.  Clicks are short noise impulses so it makes sense 
to use this filter.  We’ll continue using the demo1.wav file.  Make sure that your top wave file is 
highlighted in yellow.  To choose the filter, click on the Filter menu item and choose EZ-Impulse Noise.  
You’ll see the filter open like this: 
 

 
 

Figure 1- The EZ Impulse Filter Appears 

 
Note that the filter takes up only a portion of the screen.  You can still see part of the waveform and all the 
menus and icons.  You can move this filter window around on your screen and position it wherever you 
want.  Just grab the title bar at the top of the filter window and drag it around.  Try it now. 
 



 

Figure 2- The EZ Impulse Noise Filter 

 
In the filter window, you will see several features.  First, you’ll notice sliders that control various filter 
parameters.  These sliders can be adjusted while you listen to the audio as you did with the EZ Clean filter, 
so you will instantly hear the result of any changes you make.  Our sliders are labeled Scratch and Crackle 
in this filter. 
 
Next, you’ll have Radio buttons that control other aspects of the filters.  Again, you can change them while 
listening, so you’ll hear the results instantly.  The radio buttons in the Impulse filter are Speed and 
Accuracy. 
 
In every filter, just like our EZ Clean demo, you will have a Preview button.  This is the most important 
button here.  This button will start the audio playing while the filter is processing it.  You will hear the 
results of the filter instantly.  This makes for easy adjustment of the filters. 
 
Also in every filter, you will have a Bypass checkbox.  This takes the filter in and out of the audio stream 
instantly.  When you listen to a filter being applied by the Preview button, you may want to be able to 
compare the processed audio to the original audio.  Clicking this checkbox will bypass the filter and you’ll 
be hearing the original audio.  Unchecking it will instantly put the filter back into the signal path.  This 
way, you can “fine tune” even subtle effects with DC SEVEN. 
 
Lastly, every filter will have controls for Presets.  A preset is a saved group of settings for this filter.  Go 
ahead and drop down the Preset box now – it’s the white box at the bottom of the filter.  Click on some of 
the presets and watch the sliders as they move to good starting points for common tasks.  You can tell a lot 
by looking at the name of the presets.  Now select the preset labeled Default.  This one is already set up 
with good settings for our Demo1 file.  Every filter will also have a Save and Delete button that allows you 
to save your own presets under any name you want – and delete them too! 
 
You’re probably ready to try this filter by now, but there is one more thing that is common to each filter 
that you should know.  Hit F1 now on your keyboard.  Notice that our online Help comes up with 
information on this specific filter.  This context sensitive help is available for each and every filter. 
 



Put the Help screen away and let’s clean some audio.  If you’ve already been listening to this filter, then 
shame on you for jumping ahead.  Simon has not said click the Preview button yet.  As punishment, please 
go back to page one of this tutorial and start reading again.  We’ll wait for you here. 
 
Welcome back.  Now let’s get started by clicking the button labeled Preview.  You will hear the audio as it 
is being filtered.  You will still hear the low frequency rumble and the hiss, but the clicks should be gone.  
Let it preview all the way to the end of the file.  Notice that once it reaches the end, it will automatically 
start over at the beginning.  This is called Looping and is automatic when you are previewing with a filter 
(though it can be turned off in the Edit/Preferences screen). 
 
Let’s just confirm that the clicks are gone.  To do this, check the Bypass box in the filter while it is still 
previewing.  Now the filter is bypassed and the clicks will once again be audible.  Listen for a while and 
then uncheck the Bypass box.  Now the filter is again doing it job and the clicks are no longer heard.   
 
It’s time to learn how to adjust a filter.  While you are previewing, move the three sliders to the bottom.  
This makes the filter less aggressive and it will filter less.  Notice that the clicks return as the sliders are 
moved down.  Moving them back up results in more and more of the clicks getting removed.  All the filters 
work this way – you just adjust them while you listen.  As you might expect, if you move them too far up 
you’ll make the filter too aggressive and you’ll get distorted, stuttering or otherwise bad audio – just move 
them up enough to get the desired result.  After you’re done experimenting, just click on the demo1 preset 
again to set the filters perfectly for this file.   
 
Now click on Cancel in the Progress window seen here or just click the Preview button again: 
 

 

Figure 3- Monitor your progress 

 
This stops the preview from playing.  By Previewing, we have adjusted the filter and confirmed that it is 
doing its job.  The next step is to click on the Run Filter button.  This takes the filter just as you have set it 
and applies it to the demo1 file and creates a new file in the lower window.  This new file has been run 
through the filter and has the clicks removed. At this point, click on Close in the EZ Impulse filter window 
since we’re now done with it. 
 
Look at the two waveforms.  The top one is called the Source.  This is where we normally work on a file, 
preview filters, etc.  The bottom is called the Destination and is the result of our filtering efforts.  You can 
play either one by clicking in the respective window.  You have not changed your original file at all – 
rather we’ve created a new cleaned up version. 
 
Now it’s time to remove that rumble sound, but how can we do that if we work on the Source window and 
we really want to remove the rumble from the semi-clean file in the Destination window?  The answer is a 
little command under the File menu called Make Destination the Source.  This moves the file in the bottom 
window up to the top where we can work on it.  Click on File/Make Destination the Source now. 
 
A File Selector box will come up and suggest a new name for this file; just click on Save to accept it.  
Note:  DC SEVEN will automatically assign sequential names to new files.  While you’re new to the 
program, always just accept its recommendation as to file names. 
 
Now we are ready to remove that low frequency rumble.  To do that, we’ll choose the High Pass filter.  
Click on Filter/High Pass now.  A high pass filter will remove all frequencies below a certain point and 
allow all higher frequencies to pass.    Drop the preset box and select the preset called “Demo audio Wave 
file de-rumble”.  It’ll look like this: 
 



 

Figure 4- The Highpass filter 

 
We’ll start to go a bit quicker now since you already know what most of the buttons and controls do on this 
filter.  To find out specific info on this filter, don’t forget you can call for help by pressing the F1 key.  We 
are going to free you now to preview and play with this filter on your own, but when you’re done, return it 
to these settings by once again clicking on the demo Wave file preset.  Run the filter when you are ready.  
Now click on Close to close this filter.  
 
You now have removed two of the annoying noise types in this file.  First, we rid ourselves of the clicks 
and pops, and then we removed the rumble.  Now it’s time to get rid of that loud hiss sound.  First, 
remember to move our Destination file up to the Source window.   
 
Now click on Filter and select the Continuous Noise Filter.  This filter is perfect for hiss and other types 
of continuous noise.  Also, click on View and make sure you have Time Display checked at this time.  The 
Time Display box shows you various timing calculations with the program and will come in handy, as you 
will see.  Your screen should look something like this: 
 



 

Figure 5- The Continuous Noise filter is awake 

 
The Continuous Noise filter is one of the coolest in the whole program so follow along carefully here.  This 
filter will remove just about any continuous noise in a program, but it needs you to give it a sample of this 
noise.  Once it is able to examine the noise, it will be able to seek it out and get rid of it.  Play the file now 
using the Play button at the top and listen carefully to the first couple of seconds.  You will hear an area 
right at the beginning, which contains only the noise and no good audio.  That’s a great spot from which to 
grab a sample of the noise.    
 
To do this, we need to click and drag with our mouse to select this area.  The area highlighted in yellow in 
the illustration above is the area we want to select.   Just click about ½ inch from the left edge and, while 
holding the mouse button, drag all the way left.  Let the mouse button go and you will see an area 
highlighted in bright yellow.  This is the area you have selected.  Move the mouse pointer over either edge 
of the selected area and the pointer will turn into a Left/Right indicator.  Click and drag as necessary to 
select an area from the beginning of the file that is about .5 seconds long.  Use the “Span=” display in 
the timer window to confirm that your selection is around ½ second long. 
 
Now hit the spacebar.  You’ll play only the selected area.  It’ll be quick.  This allows you to audition a 
selected area to make sure you are really working on the correct area (does not contain silence or desired 
signal).  You should only hear the hissing noise.  Again, your selected area should look like the one shown 
above. 
 
It’s time for the fun part.  You will like this.  Hit the Sample Noise button in the Filter window.  The filter 
will analyze the noise sample and will display the frequency characteristics of the noise in red.  The blue 
line is the filter that has been designed to get rid of this noise.  Notice how they track with each other.   
Yours should look like this: 
 



 

Figure 6- Continuous Noise Filter does its job 

 
If you have jumped ahead again and clicked on Preview, there will be no lunch for you today.  First, we’ve 
got to explain those little blue dots on the filter line.  Notice how the blue line is above the red noise 
sample?  The higher the blue filter line, the more filtering occurs at that frequency.   The blue dots are 
called Control Points and allow you to adjust the amount of filtering for frequency components in the 
vicinity of the control point manually.  We’re going to do that in a second, but the Help file contains all the 
complete info on this filter. 
 
Before we click on Preview, we need to again select the whole file so we’ll hear the whole thing and not 
just our ½ second noise sample that is now selected.  To select the whole file, just double click anywhere 
in the waveform display.  Notice how the whole thing gets highlighted in yellow.  Now, go ahead and 
click on Preview.   
 
Listen to the audio.  The clicks are gone.  The rumble is gone and the hiss is gone!  Well, not quite.  You 
can still hear a bit of hiss can’t you?  While Previewing, click the bypass button a few times to take the 
filter in an out of the signal path.  Yes, the hiss is reduced, but there is still some of it there.  Let’s adjust 
this filter to get rid of all of the hiss. 
 
Make sure your bypass button is NOT checked and make sure you are previewing the audio.  Now grab the 
2nd control point from the right side and move it up a bit as shown below. 
 



 

Figure 7- Tackling the remaining hiss 

 
It’s like magic, isn’t it?  The hiss completely goes away because you told the filter to be a bit more 
aggressive on the high frequencies.  Remember, moving the blue line up makes it filter more.  Now stop 
the preview, click on Run filter, and close the Continuous Noise filter. 
 
You now have a Destination file that is completely restored.  To finish, click on File/Make Destination the 
Source, accept the file name and you’re done.  This file is the completed version and all others can be 
deleted or saved if you want each processing step before and after the saved file.  You can now exit the 
program or close the files using the commands under the File Menu. 
 
What you’ve learned in this section 
In this quick Step by Step guide, you’ve learned how to change to Classic Editing mode, launch the 
program, how to select filters, how to preview them, how to bypass them, how to load and save presets, 
what are Source and Destination files, how to apply multiple filters to a single file, how various filters work 
and much more.  Not bad for a few minutes!  Next, we’ll give you a more advanced Step by Step in which 
you get to use the most powerful feature of DC SEVEN, the MultiFilter. 
 
Advanced Record Restoration Step By Step Guide 
You learned a lot in the last Step-by-Step Guide, so let’s continue by restoring this same file using a 
completely different approach.  This will show you the flexibility and power of DC SEVEN and will 
introduce you to our powerful MultiFilter.  Also, we will do this advanced restoration Step-by-Step Guide 
using our Fast Edit Single Screen mode from earlier.  We’ll assume you’ve done the Basic Guide above 
and are therefore comfortable with the basic functions of the program so we will take this at a little faster 
pace.  As before, the actions are expected to perform will be in Bold type.  Let’s get started! 
 
First, we want to make sure that you are in Fast Edit mode.  To do this, click on Edit/Preferences and 
make sure the box labeled Enable Fast Edit is checked.   If it’s not already checked, put a check mark in 
the box by clicking it.  Hit OK.   Now close all of the audio files currently in the window.   The next wave 
file you open will show in a single screen again. 
 
Remember, Fast Edit mode is a single screen mode of operation with no Source or Destination file window.  
This mode of operation has the advantage of allowing almost instant cuts, pastes and copies on even very 
large files.  It also may be more familiar to users of traditional audio editing programs.  You can change 
from Fast Edit to Classic Mode anytime you want. 



 
Next, we want to enable the Fast Edit History box by clicking on View and then checking Fast Edit 
History.  This will open your History box.  This box will show you everything that you do with this file in 
the order you do it.  It also allows you to return to an earlier state of the file quickly and easily.   
 
Now open the Demo1 Wave file in the same way we did before.  Select an area near the center of the file 
using a mouse click and drag.  Your screen should now look similar this: 
 
 

 

Figure 8- A highlighted section in Fast Edit mode 

 
 
Let’s cut out the highlighted area.  Just click on Edit and then Cut.  Boom! It’s gone!  Fast Edit mode is 
called that because it’s FAST.   You will now have two entries in your History window – the top one is for 
the original file as opened, and the second one for the version you now see in front of you which is 
somewhat shorter.   
 
Click on the first entry in the Fast Edit History window now.  The original file instantly comes back!  Did 
I say this thing was fast?  Everything you do will show up in the history window and you can bounce 
around your various versions of a file at will.  Click on the first and second entries a few times to confirm 
this and then right click on the second entry and choose Delete.  You just deleted the cut up version and 
we’re back to the original file. 
 
Now click on Filter and choose MultiFilter.  Double click anywhere in the waveform display to select the 
entire file for processing or left click and drag to select a segment of the file.  Notice how DC SEVEN 
allows you to select an area or the entire file while the filter windows are open.  This is a very handy 
feature. 
 
The MultiFilter is one of the most powerful features of DC SEVEN.  It allows you to string together several 
filters and preview or apply them sequentially or all at once.  This saves a lot of time and makes it possible 
for users to create some incredibly sophisticated filter setups.   
 
Notice that the MultiFilter has an input on the left side and an output on the right side.  Between the input 
and output is a signal path.  You can drag any filter you want into this signal path.  At this time, remove 
any filters that are in the signal path by clicking on them and dragging them out of the signal path.   



 
Remember when we did the Basic Step by Step Guide above, we used three filters; the EZ Impulsive noise 
filter for clicks, the High Pass filter for rumble and the Continuous Noise filter for the hiss.  Drag these 
three filters into the signal path with the EZ Impulse filter on the left side followed by the High Pass filter 
and then the Continuous Noise filter on the rightmost side.  Now double click on the EZ Impulse filter 
icon in the signal path of the MultiFilter.  Your screen should look something like this: 
 
 

 

Figure 9- Working with the MultiFilter 

 
To open the individual settings for any filter in the MultiFilter signal path, just double click it and make 
your settings.  For the EZ Impulse filter, drop the preset box and choose “Demo1.wav declicker”.  You 
could preview and adjust while listening here, of course, but we’ve already got some good settings 
available as a preset.  Close the EZ Impulse filter window. 
 
Now Double click on the High pass filter and select the “Demo Audio Wave file De-Rumble” preset.  
Close the High Pass filter window when done. 
 
Lastly, open the Continuous Noise filter and choose the “Demo Audio Wave file DeNoise” preset.  Close 
the window.  We used these presets only because they are available.  You can always choose any preset or 
you can set the filters yourself by just previewing as we did in the Basic Step by Step guide.   
 
Note:  Each individual filter can be previewed even in the MultiFilter. 
 
Now we have three filters strung together.  Click the Preview button in the MultiFilter window.  You will 
hear the audio being filtered by all three of these filters.  Click the Bypass button a few times to marvel at 
what is happening here.  Feel free to giggle and then cancel the preview. 
 
Now we’re going to add a fourth filter.  Drag the Paragrahic EQ into the signal path and put it last in line 
(on the rightmost side).  Double click the Paragraphic EQ to open its adjustment window.  Now click on 
the MultiFilter Preview button.  You may have to move the Paragraphic out of the way to access this 
button.  You are now hearing the audio filtered thru 4 filters.  Make sure the Bypass button is not checked.  
While the preview is happening, find the blue control point in the Paragraphic EQ that is close to 110 Hz.  
You can see this on the horizontal scale on the bottom of the EQ adjustment area.  Move this up to increase 
the bass frequencies in our old recording.  The more you move it up, the more low frequencies you get.  It 
should look like this: 
 



 

Figure 10- Using the Paragraphic EQ 

 
You should notice that you are applying all four filters at once and you are adjusting one of them.  The 
results of your adjustments are instantly heard while all the filters are being applied.  Cancel the preview, 
run the filter, and Save the file by going to File/SaveDestination As..  Fast Edit mode requires that you 
save files when you are done. 
 
What you’ve learned in this Advanced Step by Step Guide 
 
You now know how to choose and use Fast Edit Mode, how to bring up and use the MultiFilter, and how to 
Preview and adjust while using the MultiFilter.    
 
Live Mode Step by Step Guide 
 
This guide will introduce you to another major feature of the program.  We assume you have mastered the 
other concepts we introduced in the Basic and Advanced record restoration Step by Step guides.  Please 
make sure you have done these earlier guides before attempting this one. 
 
Live mode is a powerful feature of DC SEVEN that allows you to remove noise and enhance audio as it 
happens.  You do not have to record the audio to the hard disk before applying filters.  This is useful for 
cleaning up radio reception for Hams, SWLs and Forensic users.  If you have your computer connected to 
your home stereo, you can use Live mode to actually restore your records while you play them.  It can also 
be used “on site” by Forensic users who may need to listen to (and record) surveillance audio as it happens. 
 
To use Live mode, make sure you have your speakers connected to the sound card output and an audio 
signal connected to the line level input.  This audio signal can be from a radio, turntable (with preamp) or 
any other signal.  For this Step-by-Step guide, we’re going to assume you are using a radio to provide a 
signal to the program.  In this case, you would connect the headphone or other audio out of your radio to 
the line input of your sound card.   
 
Turn on the radio and you should hear audio from the speakers connected to your computer.  This step 
depends somewhat on the brand and model of sound card you have, but the great majority of sound cards 
will simply take whatever audio appears on the input and send it directly to the output of the sound card.  If 
you don’t hear anything, just keep going in this Guide, as we’ll check everything out a bit later. 
 
Now turn off your Radio and open the file called “Radiodemo.wav”.  It’s in the same directory as the 
other demo file.    Before we do this live, we’re going to experiment a bit with a recorded bit of audio.  
 



Once the file is loaded, listen to it.  You can hear that there is A LOT of noise in this file.  It is 
understandable, but would not be fun to listen to due to all the noise.  Once the file has finished playing, 
open the MultiFilter (under the Filter Menu) and choose the preset called “Live Mode Demo Cleanup – 
SW Radio”.  We have provided in this preset some tools that are useful for this demonstration file.  This 
will also be a good starting point for your own efforts as you use the program in Live mode. 
 
Double click the Continuous Noise Filter to open its adjustment window.  You can look at the settings for 
all the tools in the MultiFilter preset and you should be able to understand what they are doing based on 
your learning so far.  Remember, you can always open a specific filter and then hit F1 to find out about it.  
Your screen should look something like this: 
 

 
Figure 11- Multiple Screens Working Together 

 
We want to bring your attention specifically to the Continuous Noise filter here because we are dealing 
with a concept that you might not have considered – How do I use this filter in Live mode when I can’t take 
a sample of the noise?   Remember, the audio is happening in real time and is typically not recorded to the 
disk at all in Live mode.  It’ll therefore be impossible under these conditions to actually take a noise 
sample.  Our preset setting here shows how you can deal with this.  Notice that the filter is set to provide a 
fairly large amount of attenuation to the low frequencies and the higher frequencies (remember, the higher 
the blue controls, the more noise is removed at that frequency).  With radio signals, we will seldom care 
about very low or very high frequencies anyway, so this setting gets rid of a lot of noise without unduly 
bothering our good signal.  The controls between 300 hz and 3,000 hz (which are speech frequencies) were 
then simply adjusted for good results.  Go ahead and hit the MultiFilter Preview button now.  Click 
Bypass in and out to hear the improvement.   
 
Notice the slider labeled Attenuation.  This control determines the overall amount of filtering that is going 
on for the entire filter.  If you move this up, it will filter more overall.  While Previewing, adjust the 
Attenuation slider to find the point you like best.  You’ll find that this very weak signal is now quite 
understandable – if you speak German.  The other filters are also adjustable, of course.  You’ll quickly find 
that there is a tradeoff here.  The more aggressive you make the Continuous Noise filter, the more digital 
artifacts you will induce.  Just adjust it to please your ears. 
 
Now stop the Preview and let’s go into Live mode.  Turn on your radio so that you can hear the signal in 
your computer speakers.  Note:  if you don’t hear anything continue on anyway as some sound cards don’t 
monitor incoming audio by default.  Double click the leftmost icon in the MultiFilter so that you can 
adjust your audio settings.  Do that and then click on the button labeled “Live Preview” and the program 
will immediately start providing filtered audio to your speakers.  You should certainly be hearing audio 
now.  Keep in mind that in this demo version, Live Preview will only be active for 60 seconds. 
 
Your screen should look like this in Live mode: 
 



 
Figure 12- Live Mode is Engaged 

 
Important -- Do you hear two versions of the audio – one a bit later in time that the other like an echo 
effect?  If so, you need to turn down the input of your sound card.  If you have a standard sound card, just 
double click the speaker icon in your tray and choose Options then Properties.  Now click on Recording 
and then click “OK”.  Now move the slider labeled Line Input or Line down to the bottom.  The echo 
should go away!  If you have a more sophisticated sound card, refer to its documentation to find out how to 
turn off monitoring or turn down the Line Input control. 
 
You cannot only process audio in real time, but you can record it as well.  Just click the Log to Disk button.   
 
Here’s a tip.  You can now add or change the filters as you please.  A good one for radio work is the 
Dynamic Processor using the ALC mode.  This can help a lot with fades in a signal as it will even out the 
audio in real time.   
 
What you have learned: 
In this Step-by-Step Guide, you’ve learned how to use the MultiFilter in Live mode to process audio as it 
happens.   You’ve learned how to adjust your sound card for Live mode – remember, however, that some 
low quality sound cards cannot record and play at the same time and therefore can’t be used in Live mode.  
You also learned how some filters could be used to make radio reception much better. 
 
Which Tool Do I Use? 
Probably the most frequently asked question we get each day is “How do I get rid of a certain type of 
noise?”  Certainly, the more you use this product, the more proficient you’ll become at picking the right 
tool to match the noise you’re trying to remove.  But for now, if you’re new to the game, we’ve included 
this handy chart that may help you get a jump on finding the tools that match your problem areas.   
 
Filter Finder 

Sound 
Restoration 

Category 
 

Sound Defect 
or Task to be 

Performed 

Filter   Type 

Early 
Acoustical 
Cylinders and 
Discs  

"Pops" Impulse Noise (Ez-Impulse or Expert Impulse Filter) 

 "Crackle" Narrow Crackle, Average, Median or Continuous Noise Filter 
 "Distortion" Low Pass Filter or De-Esser in the Dynamics Processor 

 "Hiss" Dynamic Noise Filter or Continuous Noise 
 "Rumble" Highpass or Continuous Noise Filter  
 "Thin Sound" Graphic Equalizer 
 "Reverse Skip" Cut 
 "Forward Skip" Copy and Paste Insert 
 Skip / Miss- Speed Change Filter / Fractional Speed Mastering 



tracking 
 “Thumps” Selective use of the High Pass Filter (set to 6 dB/Octave) 
 “Off Pitch” Speed Change Filter 
LP's & 45 
RPM Records
  

"Ticks" Impulse Noise or EZ Impulse  

 "Pops" Impulse Noise or EZ Impulse 
 "Distortion" Low Pass Filter 
 "Rumble" High Pass Filter 
 "Shrill" Graphic Equalizer 
 "Reverse Skip" Cut 
 "Forward Skip" Copy & Paste Insert 
 Noise between 

Cuts 
Dynamics Processor – Expander / Gate 

 Muddy Bass on 
Stereo 
Recordings 

Channel Blender 

 Stereo “Ping-
pong” effect 

Channel Blender 

 “Off Pitch” Speed Change Filter 
Magnetic Tape 
Recording 

"Hiss" Dynamic Noise Filter or Continuous Noise Filter 

 “Highs Loss” Time Offset (azimuth correction) 
 “Smeared” 

Stereo   Image 
Time Offset (azimuth correction) 

 Clipping 
Distortion 

De-Clipper  

 “Off Pitch” Speed Change Filter 
AM Radio or 
Short Wave 
Radio 

"Hiss" Dynamic Noise Filter or Continuous Noise Filter 

 “Static” Impulse Noise (Ez-Impulse or Expert Impulse Filter) 
 Line Frequency 

Buzz 
Harmonic Reject Filter 

 Volume Fading Dynamics Processor ALC 
 Heterodyning 

“Whistle” 
Notch Filter or Multiple Notch Filters 

AM Broadcast  "Whistle" Notch Filter (Europe - 9 KHz) 
(US - 10 KHz) 

 Line Frequency 
Buzz 

Harmonic Reject Filter 

 Volume Fading Dynamics Processor ALC 
   
FM Stereo 
Broadcast 

Multi-path 
Distortion 

Dynamics Processor / De-Esser or Channel Blender 

 Multiplex 
Noise 

Channel Blender 

 Ignition Noise / 
Static 

Impulse Noise Filter 

Live 
Recording 

"Feedback" Notch Filter 

 "Hum" Notch Filter 
 "Mic 'P' Pop" Highpass Filter 
 "Dead" Dynamic Noise Filter (spectral enhancement mode) 



 ‘Digital Sound” Virtual Valve Amplifier / Tube Warmth 
 Street Noise CNF Spectral Subtraction 
 HVAC Noise CNF Spectral Subtraction 
 Hum Notch Filter 
 Buzz Harmonic Reject Filter 
 Sibilant “Ess” De-Esser 
 Digital 

Clipping 
Limiter Preset in the Dynamics Processor 

Telephone 
Conversation 

"Intelligibility" Bandpass Filter  

 “Noisy - 
Random Out of 
Band” 

Brick Wall Filter in Bandpass mode or Band Pass Filter in Chebyshev 
Mode  

 "Noisy – In 
Band" 

Continuous Noise Filter 

 "Muffled or 
Garbled" 

Median Filter (large sample size) 

 Variation in 
loudness 
between parties 
(near party/ far 
party gain 
compensation) 

Dynamics processor / Compressor / ALC  
 
Punch and Crunch in ALC mode 
 

 Warbling 
Tones 

Adaptive Filter used in Keep Residue Mode 

Surveillance 
Recording 

Cancellation of 
Radio / or TV 
using a 
reference track 

File Conversions (Left – Right Mode) 
 
Adaptive Filter in Reference Mode 
 
Continuous Filter in DSS Mode 

 Automatic 
Voice 
Activated 
Recording 

Multifilter operating in VOX mode 

 Automatic 
Time Activated 
Recording 

Timer Recording Function 

 Noise isolation 
and 
identification 
Poor Speech 
Articulation  

Slot Filter 
 
 
Median Filter w/ Weighting 

 Varying 
Random Noise 
Profile 

Adaptive Filter 

 Varying 
Coherent Noise 
Profile like 
music playing 
behind speech 

Continuous Noise Filter in DSS Mode with reference track  

 DTMF Tone 
Amplification 

DTMF Presets found in the Paragraphic EQ 

 DTMF Tone 
Identification 

Spectrum Analyzer 



 Voice Masking Speed Change + Stretch & Squish Filters 
Forensics 
Audio 
Analysis & 
Enhancement 

Gunshot 
Ballistic 
Timing 

Markers and Time Display / Spectrum Analyzer 

 Gunshot 
Ballistic 
Identification 
Matching 

Time Display and Spectrogram  

 Voice 
Identification 

Spectrogram 

 Analog Tape 
Deck Azimuth 
Correction 

Time Offset Adjustment in the File Converter 
 

 
 

Person Talking 
too fast for 
Transcription 

Stretch & Squish 

 Voice Pitch too 
High 

Speed Change Filter 

 Tape 
Authenticity 

Spectrum Analyzer 

 Reference 
Channel 
Acoustical 
Compensation 

Bandpass Filter plus 20 Band Equalizer plus Reverb 

 Poor 
Intelligibility 

20 Band Graphic EQ 

 Adaptive Noise 
Rejection 

AFDF in the Continuous Noise Filter 

 Narrowband 
Noise Rejection 

30 Band EQ 

Optical Movie 
Soundtracks
  

"Pops"  Impulse Noise 

 "Crackle" Narrow Crackle, Median 
 "Thuds"  Highpass Filter 
 "Hollow" Graphic Equalizer 
 “Film Flicker” Harmonic Reject Filter 
   
Television / 
Video 

Vertical Sync 
Pulse Bleed-
through buzz 

Harmonic Reject Filter –  
30 Hz United States 
25 Hz Europe 

 Horizontal 
Sync Pulse 
Bleed-through 

Low Pass Filter 

Any Sound 
Source 

Mike “P” Pop Highpass Filter selectively applied 

 Low Gain or 
Volume 

Gain Change (under Edit menu) 

 Acoustical 
Feedback 
Clipping 
Distortion 

Notch or Harmonic Reject Filter 
De-Clipping Filter or Manual De-Clipping Process or 
Lowpass Filter selectively applied or Impulse Filter 
 

 De-Ess Lowpass Filter selective applied, or use the Dynamic Processor/ De-



(excessive 
sibilance of the 
pronunciation 
of the letter 
“S.” 

esser 

 Pitch incorrect Change Speed Filter 
 Line Frequency 

“Buzz” 
Harmonic Reject Filter 

 Excessive 
Dynamic 
Range 

Dynamics Processor or Punch & Crunch 

 Lacking 
Dynamic 
Range 

Dynamics Processor or Punch & Crunch 

 Top Octave 
missing 

Virtual Valve Amplifier / Harmonic Exciter  

 Top Octave 
Weak 

Dynamic Noise Filter Enhancer Mode 

 Recording 
lacks “warmth” 

Virtual Valve Amplifier 

 Too much 
Reverb 

Continuous noise filter 

 Weak Vocal Gain Change selectively applied 
 No Ambience Reverb 
 Digital 

Clipping 
De-Clipper 

 Analog 
Clipping 

De-Clipper 

 Harmonic 
Distortion 

Polynomial Filter / De-Esser 

 Intermodulation 
Distortion 

Polynomial Filter 

 Multi-Tone 
Whistle 

Spectral Filter or Multiple Notch Filters 

 Signal Over 
modulates 

Limiter Presets in Dynamic Processor 

 Noise Between 
Tracks or Rides 

Noise Gate Presets in Dynamics Processor 

 Automatic 
Noise 
Reduction 

EZ Clean Filter 

 Sterile Bass 
Sound 

VVA Fat Bass 

 Medium 
Resolution  
Frequency 
Contouring 

20-Band Graphic EQ 

 High 
Resolution 
Frequency 
Contouring 

30-Band Graphic EQ 

 Normalize 
Loudness 
Between 

Auto Leveling in the Batch File Processor 



Multiple Wave 
files 

 
 
I Just Didn’t Get It. 
Don’t worry, if you still feel intimidated by this system, help is just a phone call away.  Simply call us at 
717 764 9240 and we’ll take the time to not only answer the phone, but help you better understand the 
product.  We don’t care if you haven’t paid us any money yet.  No question is too basic.  Try us, you’ll find 
out why our customer support has been called “legendary.” 
 
How Do I Buy DC SEVEN? 
We try to make that process as simple as possible.  Simply go to the www.tracertek.com web site and 
follow the signs to our secure store or call us toll free at 866 260 6376.  Also, your demo has a way to 
simply plug in your credit card and purchase an unlock code that activates the demo to a full working copy.  
Tracer also offers a full line up of preamps, turntables, record cleaning products, record storage 
products…whatever you need to complement your collection.  
 
Thanks for reading… 
 
Your Friends at Tracer Technologies 
 
 
 

Tracer Technologies 
PO Box 189 

Windsor, PA  17356 
 

717 764 9240 
Toll Free 866 260 6376 

http://www.tracertek.com 
sales@tracertek.com 

 


